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'—K‘g CADENCE Tools for IC Design

Cadence is a set of different design tools used at
different stages of the design process.

Which tools we exactly need ?

sue <—Comnoser -> Schematic editor
Max WF}S&QS‘O -> Layout editor

ciw
LibraryMgr or

Ana/m}{r't/ ; ingsimulati
(Spectr'eS In thls‘ tutor-,a/) other single TCL file

D% -> Design Rule Check (DRC) , Layout Versus
Schematic Check (LVS) , Extraction

micromagic built-in gemini tool.
It is not Google Gemini !!
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= To start Cadence software enter: ic
= The cadence window after start up:

First with Cadence

&Iﬁmw

I icfb — Log: /home/ilhan,/CDS.log
File Tools Options Technology File

pos (lnstance "M1Y, library "NCSU Znalog Parts")

pmos (instance "M1", library "MCSU_#&nalog Parts")

CheckMicronSizeCB: Width is not a nomber. Use the wariable "n" to set this property

* Starting Frame Help Wiewer: conmand = "/cadfcadence/tools/infotools /binfinvokeviewer -m &"
* Prame Help Wiewer initialization complete.

opin (instance "PIN1", library "hasic")

Extracting "inwverter schematic

Schematic check completed with no errors.

"tutorial inwerter schematic" sawed.

mouse L: showClickInfo() M: schHiMousePopUp () E: schHiCheck&ndSawve ()

»

= To see your cadence libraries open Library

Manager from ,Tools menu”
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First

s Cadence libraries:

» Technological
Libraries (usually
names written with

upper cases)

s User Libraries

= Libraries contain cells -
basic elements of your

design

= Every cell may have
different views -
different views created
at different stages of
the design and edited
with different tools

W Kucewicz
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with Cadence

~J Al
File Edit View Design Manager Help
show Categories
Library Cell View
EXBMPLES 390X anw extracted
aMs CTL ORC
CTL_EBFL M1 Cap layout
EX&MPLES 390X M1 M schematic
NCSU &Anslog Parts ||M1 P symbol
NCSU Digital Parts | M1 POLY
NCSU Sheets Sths M2 M1
basic M3 M2
cdsDefTechLih NTAP
clkcells PTAP
designF low cap
fullcam
hpld Smle inv 1
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1. In File on the menu of
Library Manager choose
New -> Library or
Cellview.

Examplarty ..Creat New
File window"

— Create New File

Ok Cancel Defaults Aﬁp/
Library Mame tutonal
cell Hame inverter «—]
View Name layout -
Tool Virtuoso
Library path file

7 /homefilhan/cds. 1ik

/

W Kucewicz
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File Edit View Design Manager
MNew Library...
-"\-g} CE" WEW nmm

Category...

Open Shell Vindow  “p

Exit ~x

Library Name
Choose your working
directory and library name

Cell Name
Enter the cell name

View Name

Enter view name
depending onthe level of
the design hierarchy.
Eg. schematic or layout
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e

Design Example

CMQOS - Inverter
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'-.cﬂ Creating Schematics

START *The traditional method for
: capturing (i.e. describing) your
[ . Design } transistor-level or gate-level design
pecification

+ is via the schematic editor.

S : » Schematic editors provide simple,
chematic : "

[ Capture infuitive means to draw, to place and
+ to connect individual components that
®

©

®

make up your design.

* The resulting schematic drawing
must describe the main electrical
properties of all components and
their interconnections.

W .Kucewicz VLSICirciuit Design



a new schematic window

‘View Name

Indicates the level of the design
hierarchy.The correct view name
choice is "schematic" for our
example.

Click OK to finish

W .Kucewicz VLSICirciuit Design

— Create New File

0] .4 Cancel Defaults

Library Mame tutonal

Cell Name inverter

Witz [ o schematid

Tool Composer- Schematic

Library path file

7 /homefilhan/cds. 1ik

Help
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The first thing to do is to add
and place components which will
be used in the schematic.

We need the componets as folow:
‘PMOS : p-type MOSFET
‘NMOS : n-type MOSFET

VDD : vdd! global net marker
‘GND : gnd! global net marker

W.Kucewicz VLSICirciuit Design

-
Add components

Tools Design Window Edit Add Check Sheet

Component ...
Wire (harrow)
Wire (wide)
Vire Name ...
FAin ...

Block ...
solder Dot
Mote

W
W
|
P
b

10
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— Add Component

Hide Cancel Defaults Help
Library Mame NCSU_Analog_Parts Browse
Cell Name
Views Mame I
Instance Names
Array Columns l Rows l

Rotate Upsidedown Sideways |

-Add Component Window

Enter the Library Name,
Cell Name and the View

Name of the component

W .Kucewicz VLSICirciuit Design

Add components

—|Component Brow{ - | ||

Commands Help 9

Library HCSU_Analog Parts
Flatten

Filter 1

CONTENTS
Current Sources
Diodes

H Spice_Only
Microwawe Parts
Mizc Parts

N _Transistors

P Transistors
Parasitic_Devices
ELC

Spectre Only
Supply Nets

+ Component Browser
enables the designer to
browse easily through the
available libraries and select
the desired components.
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Pick up the MOS transistors
from the Component Browser
window.

‘Open the "N_Transistors"
folder by clicking once on it.

* Pick up the NMOS transistor
by clicking once on "nmos",
which is a model for a three
terminal n-type MOSFET.

W .Kucewicz VLSICirciuit Design

Add components

—|Component Brow? -

|

Commands Help

Library MCSU_Analog_Parts

Fatten
Alter

. (Go up 1 lewel)
nhsim
nbhsind
njfet
e =
e S

nmo=s
npr
usernpn

N Transistors

9
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» Click on a location
in the schematic
window, where you
want to put the
transistor.

* Use the same
procedure to select
and to place the
PMOS transistor.

Add components

—|Composer—Schematic Editing: tutorial inverter sche| - |_|

Cimd: Sel: 0

=]

Tools Design Window Edit Add Check Sheet Help

* hpl4tbP
w=sEEEs . . L L L L L L

hpl 4N
LewmsEEEN . . 0 0 0 0 L o

mouse L: showClickInfo() M:schHiMousePopUp( R:schHiCreateInst(

=

Picking up the supply voltage components involves the same steps as in
adding transistors to the schematic.

W.Kucewicz VLSICirciuit Design 13
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To connect the components
in a schematic, we use
wires by choosing Add and
then Wire (narrow) on the
menu banner.

W Kucewicz

VLSICirciuit Design

Tools Design Window Edit Add Check Sheet

Component ... |
VWire (narrow) w
Wire {wide) W
VWire Hame ... |
Fin ... P
Block ... b
Solder Dot
MHote

14
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Conecting components

— Composer—5chematic Editing: tutorial inverter sche| - | _|

Cimd: a3el: 0

==

Tools Design Window Edit Add Check Sheet Help

Connecting any two
nets in the schematic | 5

-"hp'thF'""""""'
w=sMn . . . . . . . . . . . .

is done by first - {
clicking at one of the | = ;
hets and then at the |&¢ C SRR

w0 o oo

0] 1- h er one. | |=&@en

- mouse L: showClickInfo() M:schHiMousePopUp( R:schBoomFit(l.0 0

ar o =

hlaet

Press ESC key to leave the wiring mode.

W.Kucewicz VLSICirciuit Design
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Edit properties of components

—|Composer—5chematic Editing: tutorial inverter sche|| i J‘

Crnd: Sel: 1 8
Tools Design Window Edit Add Check Sheet Help

A K

PREED

mouse L: showClickInfo() M:schHiMousePopUp( R:hifoomRelativeSc

>

2. Choose Properties =>

and then Object from
the Edit menu.

W.Kucewicz VLSICirciuit Design

<=1, Select component

by clicking on it

Tools Design Window Edit Add Check Sheet

Stretch im

Copy 5

Move M

Delete del

Rotate r

Properties Objects ...
Undo U Cellview ...
Redo U Pin Order ...
Reset Invisible Labels VHDL ...
Lahel Display ... Tool Filter ...
Altemate View

select

Search

Houte Fight o
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Edit properties of components

— Edit Object Properties
OK  Cancel Apply Defaults Previous Hext Help
Apply To only current instance
Show system W user B CDF
. ° Browse Reset Instance Lahels Display
3 ° Ed '1. The pr‘o Pe r?les - > Property Value Display
Library Name NGSU_analog Parts off
by clicking on the S
y 9 View Hame syabol] off

corresponding field. You may N
change the values for Width N W T

. CDF Parameter Value Display

Or' Length dep end I ng On your‘ Bl o hpldthp off
c o [P0 c Model Type @ system  user off

d es l 9 n S p eC I f l C 01- l O ns o Bulk node connection wddl off
Multiplier i off

Fingers i off

Width {grid units) g off

Width 900n M off

WaEh dminmen 800n M off

Length {grid units) 4 off

Length RO0R M off

eush drinEmen} B00n M off

Drain diffusion area 1.35e-1% off

W Kucewicz VLSICirciuit Design Source diffusion area 1.38e-12 off



file:///C:/Documents and Settings/kucewicz/Ustawienia lokalne/Cadence/Cadence tutorial/schematic.5.html#sch.5.3

Edit properties of components

4. Click OK after =»
editing the properties

in the Edit Object
Properties Window.

= OREED

—|Composer—5Schematic Editing: tutorial inverter sche| - | |
Cmud: Sel: 0 B
Tools Design Window Edit Add Check Sheet Help

R s K

mouse L: showClickInfo() M:schHiMousePopUp( R: hiZoomInf)

it | »

The most important parameters always appear in the schematic

window.

W.Kucewicz VLSICirciuit Design
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You must place I/O pins in your schematic to
identify the inputs and the outputs.

Tools Design Window Edit Add Check Sheet

Component ...

1. Click Add on the => menu T‘ ':"TWJ E
and then select Pin on the mae

P

h

Yire Hame ...

pull-down menu. Pin ..

Block ...
solder Dot
Mote

W .Kucewicz VLSICirciuit Design 19
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—

Add Pin

Hide Cancel Defaults Help
Pin Hames Irif
Direction input Bus Expansion & off on
Usage schematic Placement @ single  multiple
Rotate Upsidedown Sideways
— Add Pin
Hide Cancel Defaults Help
Pin Hames outd
Direction output Bus Expansion & off on
Usage schematic Placement @ single  multiple
Rotate Upsidedown Sideways
W .Kucewicz VLSICirciuit Design

2 .Enter the name
of your pins in
the Pin Names
field. Choose
the direction.

Place pins by clicking
on a lcoation in the
schematic window.

20
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Placing the pins

Connect the =>
pins to the
corresponding
nodes using wires.

The wiring
procedure is the
same as described
in the previous
steps.

W Kucewicz

mouse L: showllickInfo() M:schHiMousePopUpi R:schEoomFit(1.0 0O

=

CREMEN 0 e
Lows=2a9dEn . o . o .
-] |=FEin

— Composer—Schematic Editing: tutorial inverter sche| - | |
Cmd: 3el: 0 B
Tools Design Window Edit Add Check Sheet Help

VLSICirciuit Design
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Check and Save

Tools Design Window Edit Add Check Sheet

Check and Save =
Save (nhot needed) 5
Save As .. 5

Click Design on the menu banner => Herarchy
and then select Check and Save. Create Cellview

Mew ...

Open ...

ffurard Bty

Make Read Only

Probe

Options

Flot

Henumber Instances ...

icfb — Log: /home/ilhan/CD5.log

File Tools Options Technology File Help 1

pos (instance "M1", library "NCSU fnalog Parts") — C k
pos (lnstance "M1", library "MCSU _&nalog Parts") <= ec t e
CheckMicronSizeCB: Width is not a number. Use the wariable "n" to set this property
* Starting Frame Help Viewer: command = " /cad/cadences/tools/infotools/bin/invokeviewer -m &"

L]
* Prame Help Viewer initialization complete. f Id
opin (instance "PIN1', lihracy "hasic') message le
Extracting "inverter schematic"

eutorisl inwerter schematics saved. every time you
mouse L: showClickInfo() M: schHiMousePopUp () R: schHiCheck&ndSawe () Save a deS|9n.

=

W .Kucewicz VLSICirciuit Design 22
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-
Creating cellview

START
[ Design J If a certain circuit deSign
Specification consists of smaller hierarchical
+ components (or modules), it is

{ Schematic J usually very beneficial to identify
Capture such modules early in the design
process and to assign each such
module a corresponding symbol
(or icon) to represent that circuit
module.

[ Create Symbol }

W .Kucewicz VLSICirciuit Design 23



cellview

Tools Design Window Edit Add Check Sheet

Check and Save =
Save (needed) 3

From the Design menu, select Save fs ... s

. Hierarchy

Create Cellview and then From => create Cellview From Collview ...

Ce,lVieW News ... From Pin List ...
Open ... From Instance ...
Discard Edits ...
Make Read Only
Probe

— Cellview From Cellview g‘f’f““s

0
oK Cancel ' Defaults — Apply Help Renumber Instances ...
Library Hame Tutorial] .
o e rverted <= Check the view
Browse Display Cellviewsr W names you have TO
Edit Options m ensure that the
| From View Hame schematic To View Name symbol | tar‘ get VI eW name |S

symbol.

W .Kucewicz VLSICirciuit Design 24
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Locating the pins

— Symbol Generation Options

OK  Cancel Apply Help
AfTer‘ C||Ck|n9 Library Name Cell Hame View Hame
OK |n The Tutorial inverter symbol
Cellview From FIn Specifications Attributes
Cellview, window Laft Pins | I0F - List
t+he following Right Pins  0utp : List
WindOW pops up . Top Pins . List

Bottom Fins | List

| Load/Save Edit Attnbutes Edit Labels Edit Properties

Edit your pin attributes and locations. | Change pin locations
In the default case, you will have your | by putting the pin
name in the
corresponding pin
-output(s) on the right of the symbol. location field

*input(s) on the left of the symbol

W .Kucewicz VLSICirciuit Design 25
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In the new window,
the automatically
generated symbol is
shown.

poser—5ymbol Editing: Tutorial inverter ..
sel: 0 35

Tools Design Window Edit Add Check Help

- [@partMame] -

mouse L:mouseSingleSel M:schHiMousePopU R:schEoomFit(l.0

-

W.Kucewicz VLSICirciuit Design
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You can do the
following operations on
your symbol

‘Deleting/replacing some
existing parts

-Adding hew geometric »
shapes

Changing the locations
for pins and instance
name

Adding new labels

W.Kucewicz VLSICirciuit Design

— Composer—5Symbol Editing: Tutorial inverter s| - | _|

Cmid: Sel: 0 35
Tools Design Window Edit Add Check Help

mouse L:mouseSingleSel M:schHiMowsePopU R:schEoomFit({l. 0

27
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Check and Save - Once A

Tools Design Window Edit Add Check

» Save - doesn't check anything. Check and Save

save {(not needed) S
*Checking a symbol means Save s - &
comparing the symbol view with the i e
corresponding schematic view, by o
matching all of the pin names. Disears EYs .

Make Read Only

Probe

Options
Flot

To check and save the
symbol, choose Check
and Save from the
Design menu

W .Kucewicz VLSICirciuit Design
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- o
Simulation

Schematic ,
Capture *The electrical performance and

+ the functionality of the circuit

must be verified using a Simulation
Create Symbol J tool.

v

{ Simulation } ‘Based on simulation results, the
designer usually modifies some of

+ the device properties.

®

W .Kucewicz VLSICirciuit Design 29



-
Simulation -New Schematic Design

1.Open a new schematic.

* Follow the same procedure described in ..Open a new
schematic" to create a new schematic where you will put
your simulation schematic for the inverter.

* Give a name to your new schematic which makes it
clear that the new schematic is to simulate the inverter.

‘Note : You should first create the symbol of the circuit
schematic which you want to simulate

W .Kucewicz VLSICirciuit Design
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. Simulation - Select and place
components

The first step is to add and to place the components
which will be used to simulate the inverter.

The components we need for the simulation of the
inverter are the following :

‘Inverter - Symbol created for the inverter
VDD - Power supply voltage

‘GND - Ground line

-vdc - DC voltage source

‘vpulse - Pulse waveform generator

*C - Capacitor

W .Kucewicz VLSICirciuit Design
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- Simulation - Select and place
components

How to pick up a symbol from library, and to place it

in the schematic ?

NCsU Analog Parts
NCSU Digital Parts
NCsU Sheets ths
hasic

designFlow

hp1d 3mic

hp1d _Techlb
tutorial

All

W .Kucewicz VLSICirciuit Design

<= To pick up the
inverter symbol,
change the library
of the Component
Browser to
library, "tutorial".

32
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— Simulation - Select and place
components

After the library "tutorial" is
selected, there will be a new list of

» components which are included in
this library

- every symbol that you created within
this library will show up here.

By clicking on "inverter" in the component list in the Component
Browser, you can pick up the symbol you created for the inverter

W .Kucewicz VLSICirciuit Design

— Component Brow?| - | |

Commands Help 13
Library tutorial
Fatten
Fiter

33
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Sirmulation - Select and place
components

You can go to the schematic window and place the symbol
of the inverter to a point by clicking on it

— Composer—Schematic Editing: tutorial invTest - | |
Cmd: Sel: 0 17

Tools Design Window Edit Add Check Sheet Help

- lhverter - Ot

W

[ K
[ K
i j)/ mouse L:showClickInfol M:schHiMousePopU R:schHiCreateIns |

W.Kucewicz VLSICirciuit Design 34


file:///C:/Documents and Settings/kucewicz/Ustawienia lokalne/Cadence/Cadence tutorial/simulation.2.html#sim.2.8

Simulation - Select and place

Pick up and place the
rest of the components
required for the
simulation.

‘Place the supply nets,
"vdd" and "gnd".

‘Place the voltage
sources, "vdc" and
"vpulse".

‘Place the capacitance
which will be the output
load, "cap".

W.Kucewicz VLSICirciuit Design

—-| Composer—5chematic Editing: tutorial invTest schematic | g |J|
Cmd: Sel: 0 12
Tools Design Window Edit Add Check Sheet Help

LA s K

O w g

T Y ==
| AT e

- P

R: schHiCheckandSawe ()

mouse L: showGlickInfo() M: schHiMowsePopUp ()

Match placed componets as was
showed on the picture. Use the
same method as previously.

35
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Simulation - Define the voltage source

A DC-voltage source called
"vdd" is required as the
power supply voltage in all
digital circuits.

The value of this voltage
usually depends on the
technology used.

Edit the DC voltage field in=>
the Edit Object Properties
window and type the VDD
value which is 3.3V

W .Kucewicz VLSICirciuit Design

VDL

— Edit Ob ject Properties
OK  Cancel Apply Defaults Previous Hext Help
Apply To ohly current  instance
Show system W user W CDF
Browse Reset Instance Labels Display
Property Value Display
Library Name NCSU_&nalog Partd off
cell Name g off
View Name symbol off
Instance Name VO off
Add Delete Modify
User Property Master Value Local Yalue Display
Ivslgnore TRUE i off
CDF Parameter Value Display
AC magnitude off
AC phase off
DC voltage off
Moise file name off
Number of noiseffreq pairs & off
Temperature coefficient1 . off
Temperature coefficient 2 . off
| Hominal temperature off
36
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& | Simulation - Define the voltage source
Vpulse

» The pulse generator is a voltage source which can
produce pulses of any duration, period and voltage levels.

* This source will be used to generate the input data

Period
¢ A
Pulse Width
vl — | ' '
How to use _/—\_/_
parameters to Vo - -
define the input 2 K K
pulse waveform ?=> Delay  Rise Fall

Time Time Time

W .Kucewicz VLSICirciuit Design 37
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Simulation - Define the voltage source

The values for the=> pulse
generator parameters which
are used to define the input
waveform.

Change them using the method as
previously.

W .Kucewicz VLSICirciuit Design

Vpulse

OK | Cancel Apply  Defaults Previous| Mext

Apply To only current instance
Showr system [ user W CDF
Browse Reset Instance Labels Display
Property Value
Library Hame HCSU_Analog Parts
Cell Hame vpulse
View Hame symbol
Instance Mame | V1
Add Delete Modify
User Property Master Value Local Value
Ivslgnore TRUE
CDF Parameter Value
AC magnitude
AC phase
Voltage 1 g v
Voltage 2 3.3 %
Delay time 3n 3
Rise time H400p =
Fall time 100p s
Pulse width b s
Period I

Help

Display
off
off
off

off

Display
off

Display
off
off
off
off
off
off
off
off

off

38
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& | Simulation - Define the voltage source -

W Kucewicz

results

— Composer—5chematic Editing: tutorial invTest schematic | : J|
Cmad: Sel: 0 Z

Tools Design Window Edit Add Check Sheet Help

nouse L:

=

showClickInfol) M: schHiMousePopUp () R: schHiObjectPropecty ()

VLSICirciuit Design
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Edit the
properties of
the capacitor
which is the
output load of
the inverter.

Change capacitance =>
from the default value

(1 pF) to 25 fF

W Kucewicz

Simulation - Determine the output load

VLSICirciuit Design

— Edit Object Properties
OK  Cancel Apply Defaults Previous MNext Help
Apply To only current instance
Show systemn M user W CDF
Browse Reset Instance Labels Display
Property Value Display
Library Hame NCSU_analog Parts off
Cell Hame cap off
View Mame symbol] off
Instance Hame  CC off
Add Delete Modify
CDF Parameter Value Display
Capacitance 2Cf F off
Initial condition off
Model name off
Width off
Length off
1 Muttiplier ] off
40
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Simulation - Adding labels

* labeling a node = adding names to the wires.

* it allow to observe important nodes (or wires) during
simulations.

- adding pins (during drawing the schematic) # labeling

a hode
Tools Design Window Edit Add Check Sheet

. Co i...
How can I do it ? mpRREs

i
Wire (harrow) w
Wire (wide) W

First, select Wire wire Name ... |
Name in the Add Pin ... ﬂ

. Block ...
command list. =» Solder Dot

MHote
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Simulation - Adding labels

- type all the label hames one after the other in the
Names field

* there isn't any information related to the direction
of the nodes - only the pins are defined with a

direction.

Hitdle Cancel Defaults Help Hitdle Cancel Defaults Help
Hames I Hames in out
Font Height 0. DE2E Bus Expansion @ off on Font Height 0. DE2E Bus Expansion @ off on
Font Style stick Placement @ single  multiple || Font Style stick Placement @ single  multiple
Justification  lowerCenter Purpose @ label alias Justification  lowerCenter Purpose @ label alias
Entry Style fized offset Show Offset Defaults Entry Style fized offset Show Offset Defaults

Rotate Rotate

We will label the two wires as "in" and “out".
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'—Kﬂ Simulation - Adding labels

- After all the labels are typed, move the mouse
cursor on the schematic

* You will see the first label floating with the mouse
cursor. Click on the corresponding net to name
the net with this label.

* As soon as you put the first label, the second label
will appear on the mouse cursor.

» This procedure is repeated until you are finished
putting all label names you entered in the Add
Label window.
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Slmulnhon - Adding labels results

Note: Save your
design by using

Check and Save in

the Design
command list. Be
sure that the
CIW doesn't

report any errors

or any warnings.

W Kucewicz

Composer—5chematic Editing: tutorial invTest schematic

Cmd: Wire Hame Sel: 0
Tools Design Window Edit Add Check Sheet

LA s -

DK%%*

mouse L: mousedddBt() M: schHiMousePBoplp () F: Rotate 90
Point at location for the wire name.

H]
Help

VLSICirciuit Design
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Tools Design Window Edit Add Check Sheet

Analog Artist
Datapathf3chematic
Design Synthesis
Diva
Floorplan/Schematics
Hierarchy Editor
Mixed Signal Opts.
Schematics
Simulation

Yoy

W Kucewicz

the simulator window

<= Open the Analog Artist window.

—

Analog Artist Simulation (2)

|

Ce

#

=

Status: Ready

Design

Library tutorial

Il invTest

YViewr schematic

Design Variables

Hame Value

T=2¥ C Simulator: spectres 4
Session Setup Analyses Varahles Outputs Simulation Results Tools

fnalyses

# Type Brguments. . ... ... Enable
Outputs

# Name/Signal/Expr Value  Plot Sawe March

Help

L AL

(=]
=

o2o
=

VLSICirciuit Design
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Simulation - Edit the Simulation
Parameters

session Setup Analyses Varables Outputs Simulation Results Tools

Choose ...
Drpipis
Bt
Divaida

* there are many available analysis options you can
choose.

- each of these options provides a specific sub-region
within the Choosing Analysis window.

We want to obtain the delay information for the inverter, we
choose the transient simulation type, so that the output can be
traced in time domain.

W .Kucewicz VLSICirciuit Design
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In the Transient Analysis region, type a value in the
Stop Time field to determine how long the simulation will

take place.

W Kucewicz

Simulation - Edit the Simulation

Parameters

—|Choosing Analyses — Analog Artist Simulatiot

OK  Cancel Defaults Apply Help
Analysis # tran ac sp Spss
ilc =f pss hoise
Transient Analysis

Stop Time  30d

Accuracy Defaults (errpreset)
conservative moderate liberal

Enahled Options...

VLSICirciuit Design
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Simulation - Run the Simulation

session Setup Analyses Vanables Outputs Simulation Results Tools

- click on Outputs in
the Analog Artist
Simulation menu banner

- select To Be Plotted and
then Select on Schematic.

- when the schematic
window becomes
automatically active, select
the nodes to be observed

W.Kucewicz VLSICirciuit Design

setup ...

Delis

To Be Saved

To Be Marched

To Be Plotted Select On Schematic
il ig
Hernnve P

~|C0mposer—5chematic Editing: tutorial invTest schematic — Anz| © |J|

i
d J mouse L: showClick:

Cmd: Sel: 0 Status: Selecting outputs to be 137 ¢ simulator: spectreS 5
Tools Design Window Edit Add Check Sheet Mixed- Signal Help
&

@2

- Il AR SpoRy:

I

nfo() M: schHiMousePopUp () R: zeviharn gelutsOnSchena
[abc] | = Select on Schematic Outputs to Be Plotted 48
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Simulation - Run the Simulation

—

Analog Artist Simulation (3)

R

Status: Ready T=27 C Simulator: spectreS 6
Session Setup Analyses Varahles Outputs Simulation Results Tools Help
Design Analyses ‘-%
# B s, .. Enabl
Library tutorial Type R SR e
cell irwTest 1 tran 0 300 ves —
L] 1
View  schematic I T l
Design Variables Outputs [Ej
# HName Walue # Name/Signal /Expr Walue Plot Sawe March
1 in ves allw no
2 out ves allw no

session Setup Analyses Vanahbles Outputs

aimulation Results Tools

Run

Stop

Options

Netlist

Command Type-In ...
Output Log ...
Convergence Aids

W.Kucewicz VLSICirciuit Design

<= Start the
simulation by
clicking Simulation
and then selecting
Run.
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Simulation - Run the Simulation

— Waveform Window — Analog Artist Simulation (3) -
Active 7
Window AFoom Axes Curves Markers Annotation Edit Tools Help

tuto r"| 1] I v Test schama 'H <

Transient Response

time { s )

mouse L:awviMouseSingleSelec M: E: awwiTitleMenulE (]

=

The waveform window appears after the simulation is completed.
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Simulation - Run the Simulation

To separate the waveforms, from the menu
Axes select option To Strip..

W Kucewicz

— Waveform Window — Analog Artist Simulation (3) I

#: 27.05n y: 1.805 fin

Window Ffoom Axes Curves Markers Annotation Edit Tools

tutarial inwTest schematic

time { 5 )

mouse L:awviMouseSingleSelec M:

=

Active 7
Help

R:awwiSwitchisrisModeCE |

VLSICirciuit Design
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—|<‘g Simulation - Re-run the Simulation

If you are not satisfied with the simulation results,
there are two different aspects that can be modified :

* The simulation environment is not satisfactory.
This means that the setup to simulate your design
should be modified.Make sure that the power supply
voltages are connected properly.

* You have to modify your circuit design.

Usually, you will need to change the W/L ratios of
the transistors to meet your design specifications.
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Simulation - Re-run the Simulation

How to re-run the
simulation after
editing ?

Go back to the =>»
schematic window
and select the
symbol of your
design.

— Composer—5chematic Editing: tutorial invTest schematic — Anz| - J|

I

Cmd: Sel: 0 Status: Ready T=27 C Simulator: spectreS 5
Tools Design Window Edit Add Check Sheet Mized- Signal Help

mouse L: showClickInfol) M: schHiMousePoplp () F: hiZoomIn()

abc] | ¥
.

W.Kucewicz VLSICirciuit Design
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Simulation - Re-run the Simulation

Tools Design Window Edit Add Check Sheet

Check and Save =
. . . save (needed) 5
CI'Ck OH DGSIgn ln The => sSave As ... ~g
Hierarch escen it ...
menu banner, select p—r——— pescondiEill.
Hierarchy and then e . Edit In Place
. Open ... Show Scope
Descend Ed[t Discard Edits ... Retumn ~a
Make Editable Retumn To Top
Probe
. . Options
Click on OK in the ot
Descend window which — Descend
asks the designer which OK  Cance Help
view of the design is to be => D
edited.

The existing schematic window now displays the schematic view for
the inverter, by going one level down through the design hierarchy.
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Simulation - Re-run the Simulation

* Make the appropriate changes in the editable
schematic of the design. To change the existing W/L
ratio for a specific transistor, you have to edit its
object properties.

Tools Design Window Edit Add Check Sheet

Check and Save =
» Check and save your save (needed) 5
. Save As ... -
new schema‘nc. Hierarchy Descend Edit ... E
Create Cellview Descend Read ... e
. c c c Mews ... Edit In Place
Click on Design in the Open .. ahow Scops
menu banner, select Discard Edits .. Return ~e
. Make Editabl
Hierarchy and then ove. e
Return. Options
Plot

Renumber Instances ...
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'—Kﬂ Simulation - Re-run the Simulation

Go to the Analog Artist window and run the
simulation again.

*As the simulation runs, you can switch to the
waveform window, because the waveforms will be
updated after the simulation is finished.

‘You can iterate on your design as described in this
section of the tutorial.

*When you want to end the simulation, quit the

Analog Artist simulator. This will automatically close
the Waveform window, too.

W .Kucewicz VLSICirciuit Design
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'—K‘g Mask Layout

¢ * The mask layout is one of the most
¢ important steps in the full-custom
[ Create Symbol (bOTfom'Up) d@Sign flow.
+ ‘It describes the detailed geometries
and the relative positioning of each
Simulation mask layer to be used in actual
+ fabrication.
‘Physical layout design is very tightly
[ Layout } linked to overall circuit performance.

+ *The detailed mask layout of logic
o gates requires a very intensive and
time-consuming design effort.

W .Kucewicz VLSICirciuit Design 57



'—Kg CMOS Inverter Layout

Design Idea

To draw the mask layout of a circuit, two main
items are necessary at the beginning:

1. A circuit schematic

2. A signal flow diagram

W .Kucewicz VLSICirciuit Design
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Circuit Schematic

3el: 0 3

Tools Design Window Edit Add Check Sheet Help

The layout is drawn
according to the
schematic (and not
the other way
around).

use L: showClickInfol) M: schHiMousePoplip () E: schfoomFit(l. 0 0. 9}

While both schematics are identical, the one on the right
is drawn in a way to resemble the final layout.

W.Kucewicz VLSICirciuit Design
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The most important factor
determining the actual
layout is the signal flow.

The signal flow diagram is
just a concept that you can
visualize for a particular
circuit,

W .Kucewicz VLSICirciuit Design
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1. From the Library Manager :
File --> New --> Cellview

2. Enter cellname and choose

layout cellview

W Kucewicz

VLSICirciuit Design

File Edit View Design Manager

Mews Library...
{hun ~y | Cell Viewr...
Cmmm { Raad - Ondyd Category...

Open Shell Window  “p
Exit g

Ok Cancel | Defaults

Library Mame Tutorial
Cell Hame irverted

View Mame Layout,

Tool Virtuoso
Library path file

fome &k of fedsfeds T1iH

Help
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Virtuoso and LSW

Two design windows will pop-up after you have entered the

Edit Help

| lpwell [dg |

Tutorial
N Ihst W Fin

=
-
=
L=
=3
(7]
=
]

pwell m

el l u

'a
2
i

cwell q
active |dq
nactive|dq

pactive|dg

nselect

:

I

Emetall |dg

]

metald [dg

Ly
ol

y]
3]

| ]

W Kucewicz

VLSICirciuit Design

designh name.

X -0.90 ¥Y: 045 (F) Select: 0 dx: dy': Dist: Cimid: 2
Tools Design Window Create Edit Verfy Misc Help

M: mousePoplp () R:hiDisplayForm( NGSU createlLibFor

mouse L: showCGlickInfol)

Virtuoso
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1. Select nactive layer from the LSW

‘T[I[IIS Design Window Create Edit Venfy Misc

Rectangle
2. From the Create menu Polygon

in Virtuoso select Path
Label...

RCCTG”QIZ Instance...

r
F

P

|

I
( Create --> Rectangle ) Pin... P
Contact... o
Device...

Conics
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3. Draw the box
Select the first corner of rectangle in the layout
window, click once, and then move the mouse cursor to

the opposite corner.

X: 3.60 ¥: 1.20 (P) Select: 0 dx: 3.60 dy: 1.20 Dist: 3.795 Cmd: Rectangle 2

Is Design Window Create Edit Verfy Misc Help

*A grid of half a
lambda is used

= A

rr-
@
H
-}
o
=
5
=
=
o
=]
[
=
=
5
E
2

» F=h

mouse L: En
[sbed] | Point at the opposite comer of the rectangle:
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The Gate

1. Select poly layer from the LSW

2. From the menu Misc choose Ruler
( Misc --> Ruler )

|Tunls Design Window Create Edit Verify Misc

I The ruler is a very
handy function.

W .Kucewicz VLSICirciuit Design

Ruler

Clear Rulers

Move Orgin

Layer Tap

show Selected Set
Layer Gen...
Yank/Paste

Area Display

kK
K

t
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3. Draw poly rectangle

Design rules tell us
that poly must extend
at least by 0.6 (2
Lambda) from edge of
diffusion

W Kucewicz

X 210 Y: -0.60 (P) Select: D dx: 0.60 dy: -2.40

Tools Design Window Create Edit Verfy Misc

T
AR AR R
e e e e e e s

S
SR
i

ARARARERA
S

i
E
L?_\

mouse L: Enter Point
[abed] | Point at the opposite comer of the rectangle:

M: Pop-up Menu

VLSICirciuit Design

i
S

Dist: 2.474

Cmid: Rectangle

e

I
SR

SR
R
AR

R

e
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'—K‘g Making Active Contacts

Contacts will provide access to the drain and source
regions of the NMOS transistor.

1. Select the ca (Active Contact) layer from the LSW.
| ESEE
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Making Active Contacts

2. Use the ruler to pinpoint a location 0.30u from the
edges of diffusion.

X: 0.90 ¥: 0.90 (F) Select: 0 dx: 0.60 dy: 0.60 Dist: 0.549 Cmd: Rectangle 2

Tools Design Window Create Edit Venfy Misc Help

3. Create a square with =
a width and hight of  p
0.6u within the active
area.

mouse L: En
[sbed] | Point at the opposite comer of the rectangle:

W.Kucewicz VLSICirciuit Design
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Making Active Contacts

4. From the Edit menu choose Copy
( Edit --> Copy )

‘Tuuls Design Window Create Edit Venfy Misc

Undo u
Redo U
*You could choose to draw the pove m
Py c
second contact the same way as Stetch s
you have drawn the first one. Reshape R
Delete del
Properties... 1
*However, copying existing Connectivity
. . a3 h... 3
features is also a viable e
alternative.
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Active Contacts

When the Snap Mode is in orthogonal setting the copied
objects will move only along one axis.

Hide  Cancel Help
Change Layer Snap Mode Orthogonal
pwell diy Rows | 1 |
Columns i
Rotate Sideways Upsidedown

Copy dialog box.

W .Kucewicz VLSICirciuit Design
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Making Active Contacts

5. Copy the contact

» Select the object (click in the contact- the outline of contact
will attach to your cursor.

* Move the object and click at the final location.

X 3.00 : 0 F) Select: 1 dx: 2. = 0 Dist: 2.400 i z X 3.30

= O a8 HEBpe 2D

L%{gl
rr-
&

z
)
5
2
5
=
£
o
5
i
S
=
5
=
&
=
&
o
&
o
&
=S
s
7| g | 2=

=
= >

L?_k

Tmouse H Ak
[sbed] | Point at the location of the copy:
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'—K é Covering Contacts with Metal-1

-Active contacts define holes in the oxide
(connection terminals).

* The actual connection to the
corresponding diffusion region is made by
the Metal layer.

W .Kucewicz VLSICirciuit Design
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. Select layer Metal-1 from the LSW

......

T

[z
-

W Kucewicz

Contacts with Metal-1

VLSICirciuit Design

Note that Metal-1 has to
extend over the contact
in all directions by at

least 0.3 u (1 lambda).
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'—K‘g The N-Select Layer

Each diffusion area of each transistor must be selected
as being of n-type or p-type.

1. Select nselect layer from the LSW.

[Tsetectlss
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The N-Select La

2. Draw a rectangle extending over the active area by
0.6u (2 lambda) in all directions.

X 375 Y. 2.55 (F) Select: 0 dx: -0.45 dy: 3.15 Dist: 3.182 Cmd: Rectangle ?

Tools Design Window Create Edit Verfy Misc Help
&
&l

This is it | Our ?“
first transistor
is finished, now _q
let us make a ;EL
few million more 7
of the same ~

-)

: (e | 1

=

o

mouse Lo Enter Point M: Pop-up Menu E:
[abed] | Point at the first comer of the rectangle:
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Drawing the P-Diffusion

The basic steps invloved in drawing the PMOS
are the same.

1. Select pactive layer from the LSW __pactiveldg

s

2. Draw a rectangle » £
3.6u by 1.2 %

m

0

Note that the PMOS s

transistor will also be
sorrounded by the N-well
region.

e LB

mouse L: Enter
[abed] | Point at the opposite comer of the rectangle:
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Transistor Features

These three steps are identical to the ones done for
the NMOS.

X 6.40 ¥: 3.90 (F) Select: 0 dx: 1.50 dy: 4.50 Dist: 4.743 Cmud: 2

Tools Design Window Create Edit Verify Misc Help

Draw the gate poly
Place the contacts

Cover contacts
with Metal-1

movuse L: showGlickInfo () M: mousePopUp () F: leHiDelete ()
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'—K‘g The P-Select Layer

The p-type doping (implantation) window over the
active area must be defined using the n-pelect layer.

1. Select pselect layer from the LSW

[Cesetectfsg
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The P-Select La

2. Draw a rectangle that extends over the active area by
0.6u (2 lambda) in all direc’rions.v

X 7.95 ¥: 3.90 (F) Select: 0 dx: 1.05 d¥: 4.50 Dist: 4.621 Cmd: 2
Tools Design Window Create Edit Verify Misc Help

mouse L: showllickInfol) M: mousePoplp () E: leHiCreateRect()
[abed] | »
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'—K‘g Drawing the N-Well

Note that the drawing sequence of different layers ina
mask layout is completely arbitrary, it does not have to
follow the actual fabrication sequence.

1. Select the nwell layer from the LSW
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Drawing the N-Well

2. Draw a large n-well rectangle extending over the
P-Diffusion L

X: 12.90 ¥: 3.00 (F) Select: 0 dx: 7.20 dy¥: 4.80 Dist: §.653 Cmd: Rectangle
Tools Design Wndow Create Edit Verify Misc Help

The n-well must
extend over the
PMOS active area
by a large
margin, at least
1.8u

mouse L: Enter Point M: Pop-up Menu R:
[sbed] | Point at the opposite comer of the rectangle:
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. Placing the PMOS and NMOS
transistors

Based on our original signal flow diagram, it is more
desirable to place the PMOS transistor directly on top
of the NMOS transitor- for a more compact layout.
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Placing the PMOS and NMOS
transistors

1. Select the PMOS transistor

X: 915 ¥: 3.45 (F) Select: 8 dX: -1.65 dy: 2.70 Dist: 3.164 Crmd: 2
Tools Design Window Create Edit Verfy Misc Help

mouse L: showClickInfof) M. mousePopUp () E: hiZoomIni)
[abed] | =
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Placing the PMOS and NMOS
transistors

|1|:lt.Dri’1'ﬂ'lt:r-l:rll'l.Ill:l'llﬁ!'I'I'l|l_.l:

2. From the menu Edit o

select the option Move —
Propertes... g
Corwsee theily

A window will pop-up:

Hide | Cancel Help We have to
change the Snap
Mode option to
prell  |d9 Anyangle so that
we can move the
transistor freely.

Change Layer Snap Mode anyAngle

Rotate sideways Upsidedown
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Placing the PMOS and NMOS
transistors

3. The reference point Pick

X 3.30 Y: 4.05 (F) Select: 8 dx: -6.30 d¥: 4.05 Dist: 7.489 Cmd: Move 2
Tools Design Window Create Edit Verify Misc Help

e
After we have @
picked the @
reference point, the =
outline of the shape
will appear attached
to the cursor and we =
will be able to move
the shape around. £

mouse L: Enter Poilnt M. Pop-up Meru R: Rotate 90

[abed] | Point at the new location for the move:
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Placing the PMOS and NMOS
istors

4. Place the transistor

X 762 ¥ 4.35 (F) Select: & x: 5.599 dy: -0.45 Dist: 5.568 Cmd: z

Tools Design Window Create Edit Verify Misc Help

X

monse L: showClickInfa() M: mousePoplp () F: leHiMowe ()
[abed] | »
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Connecting the T

1. Draw a Metal-1 rectangle between NMOS and

PMOS drain region contacts
v s e w e 1 NE MiNimum Metal-1
Tools Design Window Create Edit Verify Misc Help Wi dTh i s O.9u (3
lambda), thus
narrower than the
Metal-1 covering the
contacts.

*The transistors are
completely symmetric,

I oo
regions are

mouse L: Enter Point M: Pop-up Menu F:

[abed] | Point at the opposite comer of the rectangle: i nT er‘ C h ang ea b I e.
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Connecting the

Connect the gates of both transistors to form the input.

1. Select poly layer from the LSW

W .Kucewicz VLSICirciuit Design

88



Connecting the

2. F ruom -‘-he Cr-eate ‘Tuuls Design Window Create Edit Venfy Misc

Rectangl
menu select Path p roiygon
Path p
Label... |
Instance... i
) ) Fin... “P
The path options box will pop up: Contact... o
Device...
Hide Cancel | Defaults Help Conics
kMode Guided '@ Manual Change To Layer
Vadth - In the path mode you can draw
T contact lines with the selected layer.
ustification The width of the drawn line can
dustification  ZETEY . be adjusted, the default is the
Eel Type 250 minimum width of the selected
Soghs Fxtensim |0 Iayer.
Eapd Emiongion 0 Snap Mode orthogonal
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3. Start path

-Click on the
middle of the
PMOS poly
extension a ghost
line appear

‘Move this ghost
line to the NMOS

poly extension.

Connecti

X: 1.80 ¥: 2.0 (F) Select: 0

Tools Design Window Create Edit Venfy Misc

mouse L: Enter Point
[abed] | Point at the next point of the path:

W.Kucewicz VLSICirciuit Design

dX: 0.00

M: Pop-up Menu

the I

dy: -2.10

Dist: 2.100

Cmd: Path

R: Toggle LO0 ESF

Help

90


file:///C:/Documents and Settings/kucewicz/Ustawienia lokalne/Temp/Katalog tymczasowy 1 dla cadence_cz_2.zip/cadence_prezentacja/cadence2/turquoise/layout.14.html

Connecting the I

4. Double click to finish path

X 1.80 ¥: 1.80 (F) Select: 0 dx: 0.00 dy: 0.00 Dist: D.000 Cmd: Path 2z

Tools Design Window Create Edit Verify Misc Help

A single click will
finish a line segment
and let you continue
drawing, a double
click will finish the
path.

mouse L: Enter Point M: Pop-up Merm R: Toggle L0 XAV
[abed] | Point at the first point of the path:
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. \ Making a Metal-1 Connection for the

Now we have to make a connection from the poly
layer to the Metal-1 layer.

This connection can be done:

- manually by drawing a poly contact
layer between Metal-1 and poly,

-using the path command to automatically
add the contacts.

W .Kucewicz VLSICirciuit Design
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1 Connection for the

1. Starting from the poly line connecting the gates,

start drawing a horizontal poly path

Hide | Cancel | Defaults Help

2. On the Mode Guided (@ Manual  Change To Layer
Path Options Width 0.4 metall |dg
dialog box, Fixed Width
click on P oot i Jucﬂut;:!.ig:jm
Chang e To Justification center
Lay_‘_e r'ha_?d End Type flush .
fl:]Neltg /1 © Hogi Fuisasion |0

fanf Eatonsion |0 Snap Mode Orthogonal
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& | Making a Metal-1 Connection for the

This will automatically add a contact to the end of
the current path.

X: -1.50 ¥: 3.00 (F) Select: 0 dx: -1.50 dy: 0.00 Dist: 1.500 Cmd: Path P
Tools Design Window Create Edit Verify Misc Help

mouse L: Enter Point M: Pop-up Merm R: Toggle L90 XE/T
[abed] | Point at the next point of the path:
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& | Making a Metal-1 Connection for the

3. Finish the path (by double clicking)

SHIFT-F to see
all levels of
hierarchy.

CTRL-F to see a
single layer of
hierarchy.

W Kucewicz

X 2.25 ¥: 5.40 (F) Select: 0 dx: 4.05 dy: 2.40 Dist: 4.708 Cmd: Path 2

Tools Design Window Create Edit Verify Misc Help

=

B,

mouse L: Enter Point M: Pop-up Merm E: Toggle L0 XSV
[abed] | Point at. the first point of the path:
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Power Rails

Our Signal Flow Graph suggests horizontal power
and ground lines in Metal-1.

1. Draw the

Power Rail in

Metal-1
above the
PMOS

2. Draw the
Ground Rail
in Metal-1
below the
NMOS

W Kucewicz

>

X 7.0 Y: 5.40 (F) Select: 0 dx: 6.30 d¥: 6.30 Dist: 8.910 Cmd: Rectangle z

Tools Design Window Create Edit Venfy Misc Help

mouse L Enter Point M: Pop-up Menu R:
[abed] | Point at the first comer of the rectangle:
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The substrate on which the transistors are built must be
properly biased.

= -2.40 Y. 0.00 (F) Select: 0 d: -1.20 dy: -1.20 Dist: 1.697 Cmd: Rectangle z

Tools Design Window Create Edit Venfy Misc Help

1. Draw a P- &
select square &
next to the
NMOS O
transistor.

DI NE=1=

2. Draw a P-

active square
inside the P-

select area.

2 g

mouse L: Enter Point M: Pop-up Menu E:
[abed] | Point at the opposite comer of the rectangle:
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3. Draw the active contact square inside the p-type
active area.

4. Make a metal
connhection to
ground, covering
the entire
substrate
contact.

W Kucewicz

X: 0.00 Y: 0.00 (F) Select: 0 dx: Z2.40 dy: -1.20 Dist: 2.683 Cmd: Rectangle z

Tools Design Window Create Edit Venfy Misc Help

mouse L Enter Point M: Pop-up Menu R:
[abed] | Point at the opposite comer of the rectangle:
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N-Substrate Contact

The PMOS transistor was placed within the n-well,
which has to be biased with the VDD potential.

1. From the menu Create select option Instance

Tools Design Window Create Edit Verfy Misc

Rectangle r
Folygon P
Path p
Label... |
Instance... i
Fin... “p
Contact... o
Device...
Conics
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N-Substrate Contact

The instance options menu will pop-up:

Hide Cancel | Defaults Help

Library | Tutorial
Cell NTAE Browse

View symbolic

Provide: Names |13

Rows L Columns | L

seitax 2.4 pemay (2.4 Mag |L
°a Ce” name Rotate Sideways Upsidedown
° L]
library e N

%Pitch 1.2

column 1

row i

| 0.&
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N-Substrate Contact

Choose the library, cell
and cell view.

Your selection will be
transferred to the
Instance options menu.

W .Kucewicz VLSICirciuit Design

show Categories

Library
Tutorial

NCSU Analo
NCSU Digit
NCSU Sheet

ptorial

hasic
cdsDefTech
clkcells
designF low
fullcam
hpld 3mle
hpld TechLl

Close

Cell Views
HTAP ymbolic

M1 CAP
M1 MW

M1 F

M1 POLY
M2 M1

M3 M2
NTRE |
PTAP

cap
1nverter
ml n

symbolic

Filters... Help
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N-Substrate Contact

2. Move the instance to the desired location.

3. Place the instance.

The n-well in this
exapmle is not wide
enough to accomodate
both the PMOS
transistor and rge
contact, which will
obviously generate a
rule violation. This
will have to be dealt
with in the next
step.

X: 6.75 ¥: 3.45 (F) Select: 0 dX: 8.55 dy: -1.95 Dist: 8.770 Cmd: 2

Tools Design Window Create Edit Verify Misc Help

nonse L: showClickInfao() M: mousePoplp () F: leHiCreateInst()
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N-Substrate Contact

4. Make the power connection.

W Kucewicz

X 0.00 Y. 4.80 (F) Select: 0 x: 1.20 dy: -1.20 Dist: 1.697 Cmd: Rectangle z

Tools Design Window Create Edit Verify HMisc Help

mouse L: Enter Point M: Pop-up Menu E:
[abed] | Point at the opposite comer of the rectangle:
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Enclesing the substrate contact

Enlarge the n-well, so that it also covers the
substrate contact.

- draw an adjoining rectangle using the n-well layer
or
- modify the existing rectangle

1. Press F4 on the keyboard to toggle selection mode.

The information bar will start displaying "(P) Select" (P for partial)
instead of "(F) Select" (F for Full).
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Enclesing the substrate contact

2. Move cursor over the left edge of the n-well.

3. Click once to select the edge.

4. Move mouse over the selected edge (without
pressing any mouse buttons).

Cursor changes shape when you are close to the edge.
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the substrate contact

5. Press and hold left mouse button when cursor changes
above the selected edge.

X -2.70 ¥: 3.60 (P) Select: 1 dX¥: -0.90 dy: 0.00 Dist: 0.900 Cmd: Streich z

Tools Design Window Create Edit Verify Misc Help

o)

mouse L: Enter Point M: Pop-up Menu R:
[abed] | Point at the new location for the stretch:
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'—K é Design Rule Check (DRC)

Simulation

v

Layout

v

DRC - Design
Rule Check

v

W Kucewicz

*The created mask layout must
conform to a complex set
of design rules, in order to
ensure a lower probability of
fabrication defects.

* A tool built into the Layout
Editor, called Design Rule
Checker, is used to detect
any design rule violations
during and after the mask
layout design.

VLSICirciuit Design



Design Rule Checki

1. From the menu Verify select option DRC

oK Cancel  Defaults| Apply Help

Checking Method | flat hierarchical hier wfo optimization

Checking Limit | full incremental by area

Th'S Wl” pOP-LIp The Cimwenals Sel by Cursor
DRC OpTionS dlalog > Switch Hames I Set Switches

box . Run- Specific Command File

Inclusion Limit 1008

Join Mets With Same Hame

Echo Commands u

Rules File divalRC. rul,

Rules Library B |Tutorial

Machine @ local remote Machine
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Design Rule Checki

2. Start DRC

File Tools

executing:

executing:
executing:
executing:
executing:
executlng:
executing:

executing:
T T T T T T B B T

# errors

2
2

Options Technology Fle Help

drc(shlockEdge activeEdge (sep < (lambda + 2.0)) errMesg)

drc{shlockEdge activeEdge {enc < (lambda * 2.0 ercMesqg)

dre (activeEdge shlockEdge (enc ¢ (lambda *+ 3.0)) eccMesg)

drc (shlockEdge polyEdge (sep < (lambda + 2.00) ercrMesq)

drec {geomBetEdge (geomfnd (shlock geomOr (nMotOhmic pWotOhmic))) GateEdge {enc < (lambda. ..
drc (geomGetEdge (geomdnd (shlock geomls (nMotOhmic pWotOhmic))) GateEdge (f(lambda * &. . ..
savelerived (geomfndNot (geomfnd (shlock Gate) sCGateWidthCheck) errMesq)

sawvelerived (geonButting fpolyRes geombndMot(poly polyRes) (ignore == 231 errMesg)

drc (polyResEdge (width < (lambda + 5.0 ercMesg)

drc {polyResEdge (sep < (lambda *+ 7.0)) ecrMesg)

drc (polyResEdge (notch < (lambda + 7.0)) ercMesg)

drc{shlockEdge polyResEdge {enc < (lambda + 2.0)) ercMesq)

Summary of rule wiolation for cell "inwerter layoub!"  Frdddedds

Violated Rules

(SCMOS Bule 5.5 b} poly contact to poly spacing: 1.50 um

Total errors found

I

mouse L: showClickInfol) M: mousePoplp () E: iwHiDRC ()

=

A

DRC results and progress will be displayed in the CIW.

W Kucewicz
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The errors are
highlighted on
the layout.

W Kucewicz

Design Rule Checki

X: 8.5 ¥: 2.10 {P) Select: 0 dx: 7.05 dy: -0.75 Dist: 7.090 Cmd: 2
Tools Design Window Create Edit Verify Misc Help

5

mouse L: showClickInfo) M: mousePoplp () F: ivHiDEGC()
[abed] |5
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This is the completed layout of the CMOS inverter.

W Kucewicz

Final L t

®: 7.50 ¥: 4.80 (P) Select: 0 dx: 7.50 dy: 1.95 Dist: 7.749 Cmd: z
Tools Design Window Create Edit Verify Misc Help

mouse L showClickInfol) M: mousePoplp () E: leHitclearFuler ()
[abed] |-
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'—K‘g Circuit Extraction

o
®
[ Layout } * The mask layout only contains
physical data. (In fact it just
+ contains coordinates of
rectangles drawn in different
DRC - Design layers).
Rule Check
+ *The extraction process identifies
the devices and generates a
Extraction netlist associated with the

+ layout.
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Extracting from the

Before extraction make sure that the design does
not contain any DRC errors.

1. From the Verify menu select the option Extract

Tools Design Window Create Edit Venfy Misc

DRC...
Extract...
SCA...
ERC...
LV3...
Probe...
Markers
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W Kucewicz

Extracting from the

To enable the extraction of parasitic devices, a selection
parameter called a switch has to be specified.

oK Cancel | Defaults | Apply Help
Extract Method | flat macro cell full hier incre. ental hier
Join Mets With Same Name Echo Commana H
Switch Hames Extract_parasitic_caps Set Switches
Run-Specific Command File
Inclusion Limit 100
View Names Extracted extracted Excell |excell
Rules File divaEXT. rul
Rules Library B |EXaMPLES 390%
Machine @ local  remote Machine
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Extracting from the

The list of switches

OK | Cancel Help

Conwvert [nplactiwe to active
Conwvert actiwe to [np]active
Extract caps

Extract diodes

Create pselect around pactive
No parameters
Create nselect around nactive
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Extracting from the

Check the Command Interpreter Window (the main window
when you start Cadence) for errors af ter extraction.

= icfh - Log: home/fkgf/CDS.log & i
File Tools Options Technology File Help 1

executing: sawvelerivedimetall ("metall" "net") cell wiew)
executing: sawveleriwed(metall ("metalZ" "net") cell wiew)
executing: sawveleriwed(wia ("wia" "net") cell wiew)
executing: sawveleriwed(metal3 ("metald" "net") cell wiew)
execubting: sawveDeriwved(wial ("wvialZ" "net") cell wiew)
saving rep EXaMPLES 300X/ inwv/extracted

*rkkddddt Supmary of rule wiolation for cell "inw layout"

Total errors found: O

%5 55 B o BE T T B

Following a successfull extraction you will see a new cell view called
extracted for your cell in the library manager.
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W Kucewicz

el

The Extracted Cell View

A new cellview (called extracted) is generated in your library.

File Edit View Design Manager

show Categories

Library
EXAMPLES 390X

AMS CTL
CTL_EPFL

AoMPLES 390

NCSU Analog Parts
NCSU Digital Parts

NCSU Sheets 8Bths
hasic
cdsDefTechLihb
clkcells

des1gnF low
fullcam

hpld 3mlc

Cell

-

finy

DRC

M1 CAP
Ml N
Ml P
M1 POLY
M2 M1
M3 M2
NT&P
PTAP
cap

inw 1

VLSICirciuit Design

ll

Help

Viewr

extracted

layout
schematlic

symbol
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The Extracted Cell Vlcw

X: 5.40 Y: 6.00 {(F) Select: 0 dx: Dist: 17
Tools Design Window Create Edit Verfy Misc Help

Load the

cellview.
>

monse L: showClickInfo() M: mousePoplp () F:hiZoomdbsolutescale (hiG

rarerr

Notice that only the I/O pins appear as solid blocks and all other
shapes appear as outlines.
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The Extracted Cell View

The red rectangles indicate that there are a number of
instances within this hierarchy.

X -9.09 ¥: 16.50 {F) Select: D dx: dy: Dist: 12
Tools Design Window Create Edit Verfy Misc Help

Press
Shift-F to
see all of
the
hierarchy.

. : . ufamk@uwu o
wF gﬁﬁnﬁmc 15

.+41

"':'In-'1r.............

movse L: showClickInfof) M: mousePopUp () E:hiGetCurrentWindow () -=
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The Extmtcd Ccll Vizw

X 375 Y: 14.25 (F) Select: D X b Dist: 12

Tools Design Window Create Edit Verify Misc Help

mouse L: showClickInfol) M: mouwsePoplp () E: hifoomIn)

Notice a number of elements, mainly capacitors.
They are parasitic capacitances.
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'—K‘g Layout versus Schematic Check

O .. :
° » Compares the original network with
the one extracted from the mask
DRC - Design layout
Rule Check
+ - Proves that the two networks are
indeed equivalent
Extraction
+ - Provides an additional level of
confidence for the integrity of the

LVS Layout versus design
Schematic Check

+ *Ensures that the mask layout is a
correct realization of the intended
circuit topology
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versus Schematic Check

1. From the Verify menu select the option LVS.

Tools Design Window Create Edit Verify Misc

DRC...
Extract...
SCA...
ERC...

If you had previously run a LVS check, this LVS...

would pop-up a small warning box. Make Probe...

sure that the option Form Contents is Markers

selected in this box.

> OK | Cancel

The selected LYS Run directory does not match the Run Fonm.

Use @ Form Contents Run Directory Contents

Differences: |Extracted Library Name: wp19801
Extracted Cell Wame: SREG TEST
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Although there are a
number of options
for LVS, the default
options will be
enough for basic
operations, select
Run to start the
comparison.

W Kucewicz

versus Schematic Check

Commands Help | 13

Browse

Run Directory |L¥d

Create Hetlist M schematic M extracted
Library |EXAMPLES 3003 EXAMPLES 390%
Cell i ing
View schematic extracted
Browse | Sel by Cursor | Browse | Sel by Cursor
Rules File dival¥s. rul} Browse
Rules Library W EXaMPLES 390
LYS Options B Rewiring Device Fixing
Create Cross Reference M Terminals
Correspondence Fle lws corr file Create
Priority | Run local
Run Output Error Display kMonitor Info
Backannotate Farasitic Probe Build Analog Build Mixed
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'—K‘g Layout versus Schematic Check

Even for a very small design the LVS run can take some time
(minutes).

? Job 'Yhome/kgf/cds/LVS’ that was started at ‘Nov 14 16:45:17 1998’ has succeeded

OK Cancel Help

The succeeded message box

The above message box, indicates that the LVS program has
finished comparing the netlists, NOT THAT THE CIRCUITS
MATCH. It might be the case that the LVS was successful in
comparing the netlists and came up with the result that both
circuits were different.
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L versus Schematic Check

To see the actual result of an LVS run you have to
examine the output of the LVS run. The Output option is
right next to the Run command

Terminal correspondence polnts

1 grd !
i 11

3 ouk
4 wdd |

The net-lists match.

layout schematic

1nstances
urn-matched 1] 1]
rewyired 1] 1]
S1ZE BCCOCS 1] 1]
prurned 0 0
active @ @
total @ @
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Post-| Simulation

[ S e } Steps of Postlayout Simulation
* Extracting from the Layout
+ * The Extracted Cell View
» Layout Versus Schematic
[L\S,c?helr-r?gt(i):t c‘:’ﬁz"‘j + Summary of the Cell Views
- Simulating the Extracted Cell

+ View

Post _Layout
Simulation

(First three described earlier)

FINISH
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of the Cell Views

1. Schematic view

l
Cind: Sel: 0 15

For' C(ny deS ign: Tools Design Window Edit Add Check Sheet Help
the schematic N
should be the T
first cell view
to be created.
The schematic
will be the basic
reference of
your circuift.

& K

:I

.o f [141.DF e e e e e
. —hﬂﬂ . . . P . . PR . . P . .
, Jf

P
%

)]
Mo

DK EE S

Lo _{ hp‘.IH.I:H
P |— IE‘E‘I'I ...............

. gndl

1

IR B

oy |mouze L. showClickInfo () M: schHiMousePopUp () R:hicloseWindow {getCurren

= B 5
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of the Cell Views

2. Symbol view

After you are done with [Fa™"" s

the schematic, you will
need to simulate your
design. The proper way
of doing this is to
create a seperate test
schematic and include
your circuit as a block.
Therefore you will need
to create a symbol.

Tools Design Window Edit Add Check

[@partMamel

mouse L: mouseSingleSelectPt M: schHiMousePoplp ()

16
Help

R:hiCGloseWindow (getlurren
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of the Cell Views

3. Layout view

This is the
actual layout
mask data that

will be
fabricated.

W Kucewicz

: lll
¥ -3.00 ¥ 8.95 (F) Select: 0 o dy: Dist: ' 1
Tools Design Window Create Edit Verify Misc Help

W

mouse L: showClickInfol) M: mousePoplpi) E: schfoomFit(l.0 0. 9]
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of the Cell Views

4 Extracted view

After the layout

has been finalized,

it is extracted,
devices and
parasitic elements
are identified and

a netlist is formed.

W Kucewicz

X -5.10 Y. b.4a (F) Select: 0 dx:
Tools Design Window Create Edit VYerfy Misc

mouze L: showClickInfol) M: mousePoplp i)

[ viriuoso Editing: EXAMPLES 390 iny oxtractod EE NS g e |

dY:

‘-:::ﬂ;a;mwn.............
o =) T_ d:: Se
Ly -_J.r_l ._I.,. ﬁ*n 1

21034

C":’In-n1r.............

Dist: 12
Help

R:hiCloseWindow (getliurcen
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B. Test Schematic

A separate cell is
used to as a test
bench. This test
bench includes
sources, loads
and the circuit
to be tested.
The test cell
usually consists
of a single
schematic only.

W Kucewicz

of the Cell Views

Crmnud:

ael: 0

Tools Design Window Edit Add Check Sheet

Ezﬁ@—@

=&
_l—I:'
A

T

i ad:=1i
f
|

= | nouse L showClickInfo()

“ m-.g_l - - . . . .
J: wele =.. . J_ e="70f - . . .

R

M: schHiMousePoplp () E: leCloseWindow()

17
Help
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Simulating the Extracted Ceall View

Make sure that you are in the test schematic, that you used to
simulate your design earlier.

1. Start Analog Artist using Tools --> Analog Artist

. . ~ Analog Artist Simulati
Tools Design Window Edit Add Check Sheet IEY Bt Simiatn _

Status: Ready T-27 C Simulator: spectreS 20
malﬂg F'J"tiﬁt— Session Setup Analyses Variables Outputs Simulation Resulis Tools Help
Datapath/Schematic pesin fralyses 5

- # Typ S ES. Enshle |,
Design Synthesis Hbrary EEMELES 350X : i —
B Cell inv_test ¥
Diva View  schematic % % I
FloorplanfSchematics Design Variables Outputs [
HiEI“ElI“[:h'f,l" Eﬂitﬂr # Hame Value # Name/Signal/Expr Walue Plot Sawe March }9/
Mixed Signal Opts.
schematics
Simulation
iyasne X Y

The Analog Artist window will pop-up.

W .Kucewicz VLSICirciuit Design 132


file:///C:/Documents and Settings/kucewicz/Ustawienia lokalne/Temp/cadence_prezentacja/cadence2/turquoise/post.5.html#post.5.1
file:///C:/Documents and Settings/kucewicz/Ustawienia lokalne/Temp/cadence_prezentacja/cadence2/turquoise/post.5.html#post.5.2

Simulating the Extracted Ceall View

2. From the Setup menu choose the Environment option.

session setup Analyses Varables Outputs Simulation Results Tools

Design ...
simulator/Directory/Host ...
Temperature ...

Model Path ...

Environment ...

atimulus

simulation Files

A new dialog box controlling various parameters of Analog
Artist will pop-up...
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Simulating the Extracted Ceall View

oK Cancel | Defaults | Apply Help
Init File
Update File

Parameter Range Checking File
Recover from Checkpoint File
Hetlist Type

Switch Views List

Stop View List
Instance - Based View Switching
Instance View List Tahle
Instance Siop List Table

Print Comments
Include/Stimulus File Syntax
Include File

Stimulus File

Alter the line called
flat (@ hirarchical _incremmental the Switch View List.

:ctreS spice cmos_sch cmos. sch schematic weriloga ahdl

spectres spice

This entry is an
ordered list of cell
views that contain
information that can
be simulated.

® cdsSpice  spectre

Switch View List spectresS spice cmos sch cmos. sch extracted schematic

W Kucewicz
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3. Choose analyses

For example DC analysis

W Kucewicz

Simulating the Extracted Ceall View

sSession Setup Analyses Vanables Outputs Simulation Results Tools

Ok | Cancel  Defaults| Spply

Analysis tran ac sp
@ dc =f pss
DC Analysis

Save DC Operating Point

Sweep Variahle

Temperature
Component Parameter
Model Parameter

Enabled

Choose ...

Eraviarder

Epadsio

Eriandins

Help
sSpss
The first step is to
determine what
parameter will be
swept.
Options...
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Choose Component

Parameter as the Sweep

Variable.

You can select the
parameter from the

schematic window after you
click on Select Component. ..

W Kucewicz

Simulating the Extracted Ceall View

Ok | Cancel Defaults| Apply

Analysis tran ac sp spss
i dc ®f pss noise

DC Analysis
Sawve DC Operating Point

Sweep Variahle

IR T Component Hame |

B Component Parameter
Model Parameter

select Component.

Parameter Hame

Sweep Range
# Start-Stop : ’
Center-Span  Start Stop L

Sweep Type
Linear
Logarithmic

# Automatic

Add Specific Points

Help

Enahled Options...
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Slmulcm the Extracted Cell View .

Cmd: Sel: 0 Status: Ready T=27 C Simulator: spectreS 19
AS ZGCh Tools Design Window Edit Add Check Sheet Mized-Signal Help

component hasa &
number of &
parameters, you &2
will be given a list
of parameters

associated with ™
the component %

you select. 4
: £
OK | Cancel
maug AC "AC magnitude" nfaf) M: schHiMousePopUp () E: schEoomFit{l.0 0.9}
phase acp "AC phase"
tecl tecl "Temperature coefficient
tcl tcl "Temperature coefficient
trom trom "Nominal temperature"
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After we have selected
the variable we can

decide, the range where
the variable will change.

This example changes the
DC voltage source
connected to the input
from O Volts to 3.3 Volts.

W .Kucewicz VLSICirciuit Design

Simulating the Extracted Ceall View

OFK | Cancel | Defaults | Apply Help
Analysis tran ac sp spss
# dc =T pss noise
DC Analysis

Save DC Operating Point

Sweep Variahle

AV
Temperature Component. Hame

B Component Parameter Select Component

KModel Parameter 7
Parameter Hame |95

Sweep Range
» Start-Stop
Center-Span  Start

1] Stop |33

Sweep Type
Linear
Logarithmic

# Sutomatic

Add Specific Points

Enabled Options...
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The last parameter
determines how the
sweep will be
performed. A linear
sweep will increment

the value of the sweep

variable by a fixed
amount.

The example uses a step size
of 10 millivolts.
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Simulating the Extracted Ceall View

Ok | Cancel | Defaults | Apply

Analysis tran ac sp spss
# dc xf pss noise
DC Analysis

Save DC Operating Point

Sweep Variable

A0
Temperature Component Name

B Component Parameter
Model Parameter

Select Component

Parameter Hame | 0%

Sweep Hange
& Start- Stop

Center-Span  Start | Stop |34 3
Sweep Type
# Linear - ® Step Size
Logarithmic Lli: Total Points
Automadtic
Add Specific Points
Enabled Options...
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Simulating the Extracted Cell View

Choose GnOTher‘ analyses Session Setup Analyses Varables Outputs Simulation Results Tools

Choose ...
Eraviarder
Epadsio
o Eriandins
For example tran, noise ect.
till you will be satisfied of Sl s ”:"“ il s
5 . Analysis ac sp Spss
YOUP Clr‘CL“T. ’ ® dc =T pss noise
DC Analysis

Save DC Operating Point

Sweep Variahle

Temperature
Component Parameter
Model Parameter

End of Design e
SEND to FOUNDRY
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